Can Smartphones Measure Radiation Exposures?

Lawrence Y Pang
Talented Offerings for Programs in the Sciences (TOPS), Marc Garneau Collegiate Institute, Toronto, Ontario

ABSTRACT

Ionizing radiation, such as X-rays, is potentially harmful to humans. Ionizing radiation can be detected by radiation detectors, which are not easily available to the public. Thus, the feasibility of using smartphones to detect and measure X-ray exposures was investigated in this work. Two sets of experiments were conducted using an Apple iPhone 4 smartphone. For one experiment, the smartphone was used as an X-ray source, while the second experiment tested the use of the iPhone as an exposure meter. Using the iPhone 4, it was found that when videos were taken during X-ray exposures, white tracks appeared in the videos, which indicated a radiation absorption event. By counting the total number of tracks in the videos (using image processing software), X-ray exposures could be determined using a calibration factor obtained from the first set of experiments. It was found that the calibration factor was strongly dependent on the video settings, but weakly dependent on the incident angle of X-rays on the phone as long as the incident angle was within ±45 degrees from the normal incidence. It was observed that, as an exposure meter, the iPhone 4 was ±20% accurate compared to a standard detector used by hospitals. The results of this work suggest that it is feasible to use an iPhone 4 to measure radiation exposures.

INTRODUCTION

It is well known that ionizing radiation, such as X-rays, have negative health effects on humans, such as radiation-induced cancer. Since humans cannot detect ionizing radiation, they rely on radiation detectors. However, these radiation detectors are only available for hospitals and industries. Alternatively, smartphones may be used as radiation detectors, which are more readily available to the general public. A smartphone is a mobile phone with advanced computing capability, which can access various applications and the Internet.

The purpose of this work was to investigate a smartphone’s potential to detect and measure radiation exposures. Using a built-in phone camera to detect radiation has been previously proposed, but such work studied instantaneous exposure rates from radioactive sources, such as gamma rays. Instead, this experiment measured exposures (the integration of exposure rates over time) from X-rays via using smartphones as exposure meters.

THEORETICAL BASIS OF USING SMARTPHONES TO MEASURE RADIATION

How can smartphones detect radiation?

An Apple iPhone 4 was used in this study, which was developed in 2010. The phone has a front (i.e. facing the user) and back (i.e. facing away from the user) camera. The back camera was used for all experiments in this study. The back camera has a 5-megapixel sensor with a 3.85 mm f/2.8 lens with 5x digital zoom and a light-emitting diode (LED) flash. It can record high definition (HD) video in 720p at 30 frames per second.
An iPhone camera uses an active-pixel (APS) or complementary metal oxide semiconductor (CMOS) sensor. An APS consists of a two-dimensional array of pixels that are covered by lenses and coloured filters. Under each coloured filter there is a photodiode used to detect light. When a visible light photon (with an energy between 1.1 eV and 3.1 eV) is absorbed by the camera, an electron is released in the photodiode due to the photoelectric effect. Typically, only one charge is produced per absorbed light photon (Figure 1a). In an image, the brightness of the pixel is proportional to the amount of charge produced in the photodiode of the pixel, and to the intensity of light incident on the pixel.

X-rays and visible light are forms of electromagnetic waves. However, X-rays are more energetic. Thus, when the camera absorbs an X-ray, a high-energy electron is released in the photodiode, resulting in ionization of other atoms along the path of the photodiode (Figure 1b). This produces a large amount of charge per absorbed X-ray, producing a brighter pixel in the photodiode. Thus, one detected X-ray will appear brighter and distinct compared to a detected light photon against a background. Figure 2a and b depicts two photographs taken with and the without the iPhone 4 exposed to X-rays respectively. In both images, the iPhone 4 camera was covered with black tape to prevent incoming signals from visible light (Figure 1b and c). In contrast, as seen in figure 2a, the X-rays could penetrate the black tape, generating signals in the camera in the form of bright dots. Thus, by capturing images with the phone’s camera covered with black tape, one can detect the presence of ionizing radiation.

How can smartphones measure radiation exposures?

Radiation exposure is a measure of radiation’s ability to ionize air, and may be expressed as roentgen (1R = 2.58 x 10-4 C/kg). The typical radiation exposure per dental film per examination is about 200 milliroentgens (mR), while the background radiation exposure at sea level is about 88 mR per year. X-ray exposure is proportional to the incident X-ray fluence (i.e. the number of incident X-rays per unit area).

Suppose that X-rays with the incident fluence (I0) are incident on a smartphone camera. Some of the incident X-rays will be absorbed and detected by the camera. The amount of X-rays detected per unit

![Figure 1.
Schematic diagram showing the underlying physics of detecting a) a light photon and b) an X-ray by a pixel element of a smartphone camera (not to scale).]

a) a pixel element not covered by black tape is exposed to visible light. An absorbed light photon releases one electron in the photodiode.

b) a pixel element covered by black tape is exposed to X-rays. An incident X-ray penetrates the black tape and releases a high-energy electron in the photodiode. This high-energy electron has sufficient energy to release more charge along its path in the photodiode.

c) is similar to a), but is covered with black tape. Light is absorbed by the tape and thus, cannot release any electrons in the photodiode.

![Figure 2.
Sample images taken by an iPhone 4 camera with and without X-rays.]

a) was taken with an iPhone 4 camera exposed to X-rays but without visible light. Each bright dot represents an event of X-ray interaction with the camera.

b) is similar to a), but without X-rays. In both cases, a layer of black tape absorbed visible light, preventing visible light photons from being detected by the camera (Figure 1c).
Figure 3.
A zoomed-in section of a sample image taken by an iPhone 4 camera exposed to X-rays. In this image, there are 8 distinct, bright tracks, each of which indicates an X-ray absorption event. Visible light photons were blocked by black tape, as in Figure 2. Using the number of tracks, a ΔI value can be determined (ΔI = number of tracks/area of camera section).

Figure 4.
Schematic diagram showing the experimental setup for determining the calibration factor K and the angular dependence measurements (not to scale). θ is the angle at which the X-ray beam is incident on the iPhone, of which θ = 0° for normal incidence.

area by the camera, ΔI, is proportional to I0 and the radiation exposure as well.

When one takes a picture with an iPhone camera exposed to X-rays, bright spots (tracks) appear, each of which indicates the absorption of one X-ray (Figure 3). Using the number of tracks, it is possible to calculate a ΔI value (where ΔI = number of tracks/area of camera section).

Additionally, by counting the numbers of tracks in an image, one can determine how many X-rays are absorbed or detected by the camera, which in turn is proportional to the radiation exposure:

Radiation exposure = K × Number of tracks, (1)

Where K is a calibration factor, which is a physical property of a given smartphone camera and can be determined through measurements, as discussed below.

DETERMINATION OF THE CALIBRATION FACTOR FOR A SMARTPHONE

Experimental setup
Figure 4 illustrates the experimental setup that was used to determine the K value for the experiments. A standard hospital detector (Unfors Xi R/F detector) was used to measure radiation exposures at the location of the iPhone. X-rays were generated by an X-ray tube (Dunlee DV 694), which produced X-ray beams ranging from 70 to 150 peak kilovoltage (kVp). By varying the X-ray generator settings, one could vary the exposure at the location of the iPhone. The iPhone camera was covered by black tape to eliminate visible light photons. In all experiments, low (352x288) and high (1280x720) resolution videos were taken during each X-ray exposure with an application called MoviePro.

In order to investigate if the calibration factor was dependent on the incident angle of iPhone's X-ray beam, the X-ray tube was rotated so that its beam was incident on the iPhone at an oblique angle (as opposed to a normal incidence). The radiation exposure was kept constant and videos were for various oblique incident angles. A week later, the first set of experiments was performed again to confirm its reproducibility, and the difference observed was small (<2%).

Image processing
Each recorded video was converted into individual frames (i.e. a sequence of images) using Free Video to JPG Converter, a free computer program developed by Free Studios.

Each frame was then imported into Image J, a free computer program developed by the National Institutes of Health. This action was completed using the ‘Import Image Sequence’ function (File → Import → Image → Sequence), creating a sequence of images (stack). All the images within the stack were arranged into an array to create a single image (montage) via the ‘Make Montage’ function.
(Image→Stacks→Make Montage). The original pixel dimensions were preserved for each original image.

Using Image J, the montage was thresholded, which required setting a threshold value. This enabled all pixels brighter than the threshold value to become a solid colour, ensuring that these pixels were distinguishable from their background. In this experiment, the threshold value was determined using the iterative method developed by Ridley and Calvard\(^6\). This was done with the 'Color Threshold' function (Image→Adjust→Color Threshold). With the appropriate settings (Thresholding method=Triangle, Threshold color=Red, Color space=RGB), each bright region was converted to red (pixel value 255,000,000), while the background did not change on the images (figure 5). Due to the thresholding method, it was possible to count the number of tracks (which were labelled in red) using the ‘Analyze Particles’ function (Analyze→Analyze Particles). The aforementioned procedures collectively took a several minutes per video.

**Results**

Figure 6 depicts the measured number of tracks as a function of radiation exposure for two different X-ray energies (70 and 120 kVp) under normal incidence (\(\theta=0^\circ\)). All data points were fitted by one polynomial curve, called a calibration curve (solid line), and there was no significant dependence of the calibration curve on the X-ray energy.

As seen in figure 7, the calibration curve was dependent on the video settings (i.e. the resolution of the videos taken during the exposures). Figure 8 illustrates that the camera sensitivity (number of tracks per X-ray exposure) was dependent on the incident angle of the X-ray. However, the change in sensitivity was less than 10% if the incident angle was within ±45 degrees from the normal incidence.

Although the calibration curve was polynomial for large radiation exposures, a linear approximation can be determined for lower radiation exposures. For radiation exposures up to approximately 1094 mR, the following linear equation fits for the low-resolution setting:

\[
y = 415x,
\]

Where \(y\) is the number of tracks and \(x\) is the exposure in mR. When equation (1) and (2) are combined, it indicates that \(K\)-at low exposures-is equivalent to 0.00241 mR/count on the iPhone 4 camera with the low resolution setting (288x352) and normal incidence.

**Figure 5.**

*Images illustrating the thresholding method.*

a) A small section of an unprocessed sample image taken by the iPhone 4 camera with radiation.

b) depicts the same section, and has been subjected to the thresholding method. It is important to note that each track seen in image a) is now solid red, as seen in b), while the background does not change. After using the thresholding method, it is possible to count the number of tracks in the image automatically.

**Figure 6.**

*Measured number of counts as a function of radiation exposure for different X-ray energies at 70 kVp (solid circles) and 120 kVp (open triangles).*

The error bars represent standard errors. The solid line fits for all data points. The videos used to arrive at these results were taken at low resolution (288x352) under normal incidence (\(\theta=0^\circ\)). The experimental setup, which produced these results, is depicted in figure 4.
TESTING THE USE OF A SMARTPHONE AS AN EXPOSURE METER

Experimental setup

In order to test the effectiveness of using a smartphone as an exposure meter, a second set of experiments were performed under different conditions, compared to the calibration conditions. It was hypothesized that despite differing conditions, one could use equation (1) and the K value (which was obtained in the previous section) to measure radiation exposures fairly accurately.

In the experimental cases numbers 1 and 2 (No. 1 and 2), X-rays were used with 100 kVp (as opposed to 70 and 120 kVp), as well as a source to detector distance of 130 cm (compared to 100 cm used in the calibration). Additionally, in cases numbers 3 and 4 (No. 3 and 4), the iPhone was exposed to X-rays scattered from a phantom. Figure 9 illustrates the experimental setup for measuring the scattered radiation.

By counting the tracks in the videos taken from this set of experiments, and using a linear calibration factor (K= 0.00241 mR/count) that was previously determined (as discussed in section III), the radiation exposure was determined for each experiment. The results were compared to the measurements of the standard hospital detector at the location of the iPhone.

Results

Table 1 summarizes the results from the second set of experiments. It is important to note that the percentage difference between the results of the iPhone and the standard hospital detector was no greater than 18%. Furthermore, the precision of the measurements was high, as the standard error was less than a few percent.

DISCUSSION

As previously discussed in section IV, the exposure values determined by the iPhone 4 were based on an approximate calibration factor K. The accuracy of the iPhone 4 as an exposure meter could be improved if the polynomial calibration curve (Figure 7) was used to directly determine the exposures from the number of counts. However, determining exposures using a simple calibration factor is much easier to compute and would be suitable for the limited processing power of smartphones.

For other cameras and other smartphones, calibration may also be done with the method explained in section III. In the future, the manufacturer could perform this calibration procedure, and radiation exposure calibration factors could be part of the smartphones’ specifications.

The value of the calibration factor K depends on the smartphone itself and several other factors. For example, the settings of the camera play an important role. Additionally, at higher resolutions, the camera is more sensitive to radiation (i.e. a smaller amount of radiation exposure will lead to more tracks). However, at low resolutions, several tracks can be confused as one single track, leading to lower sensitivity. Thus, there are different calibration factors for different resolutions. As discussed in section III, it was also demonstrated that the sensitivity is related to the angle at which X-rays are incident on the iPhone. However, the variation of sensitivity due to the incident angle is relatively small as long as the incident angle is within ±45 degrees from the normal incidence.

Key words: Ionizing radiation; X-rays; radiation exposures; radiation detectors; smartphones.
Figure 8
Angular dependence of camera response to a fixed radiation exposure. The number of counts is normalized in this case, so that the number of counts at θ= 0° is equivalent to 1, and all other numbers of counts are expressed as decimal fractions of the number of counts at 0°. The videos used to arrive at these results were taken at low resolution (288x352). The experimental setup, which produced these results, is depicted in Figure 4.

Table 1.
Exposures determined by a calibrated iPhone 4 as compared to that measured by a standard hospital detector. Here ± indicates the standard error.

<table>
<thead>
<tr>
<th>CASE</th>
<th>Exposure determined by iPhone (mR)</th>
<th>Exposure measured by standard hospital detector (mR)</th>
<th>% difference between iPhone and standard detector (%)</th>
</tr>
</thead>
<tbody>
<tr>
<td>No. 1</td>
<td>610±5</td>
<td>587±1</td>
<td>3.92</td>
</tr>
<tr>
<td>No. 2</td>
<td>20.8±0.3</td>
<td>19.18±0.03</td>
<td>8.45</td>
</tr>
<tr>
<td>No. 3</td>
<td>0.76±0.03</td>
<td>0.65±0.0.005</td>
<td>16</td>
</tr>
<tr>
<td>No. 4</td>
<td>0.24±0.01</td>
<td>0.203±0.001</td>
<td>18</td>
</tr>
</tbody>
</table>

CONCLUSION AND FUTURE DIRECTIONS
In this work, it has been demonstrated that smartphones can be used to detect and measure radiation exposures. However, a calibration factor needs to be determined before a smartphone can be used for this purpose, which can be done by a manufacturer before it is sold in the market. Future initiatives should include designing software applications for smartphones to allow their users to process images and determine radiation exposures.

ACKNOWLEDGEMENTS
I am grateful to my father for his guidance and his assistance in operating the X-ray machine. I would also like to thank Dr. W. Song of Sunnybrook Health Sciences Centre for his support of this project.

REFERENCES